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Stanovení Cu v modrém tisku metodou ICP-OES 
 

V praxi se běžně setkáváme s požadavky na kvantitativní stanovení prvků ve vzorcích 

různého skupenství. Vzorky kapalné a plynné lze poměrně dobře přímo vnášet do analyticky 

využívaných emisních zdrojů, mezi něž patří i velmi rozšířené indukčně vázané plazma 

(ICP). Vnášení pevných vzorků do excitačního zdroje abrazí např. jiskrou nebo laserovou 

ablací, je sice možné, avšak často je využíváno převedení takových vzorků do kapalného 

skupenství. Pevné vzorky se rozkládají pomocí směsi kyselin anebo zásad (příp. s přídavky 

dalších činidel) přičemž konkrétní správný postup závisí na druhu vzorku. Při rozkladu je 

nutné zajistit, aby rozpuštění vzorku bylo úplné a pokud možno rychlé, a zároveň je nutné 

zamezit ztrátám těkavých složek vzorku, případně kontaminaci během rozkladu. Účinnost a 

rychlost rozkladu lze zvýšit zvýšením teploty s využitím kahanu, topné desky nebo 

mikrovlnným rozkladným zařízením. Snáze se také rozloží rozemletý vzorek v podobě 

jemných částic než vzorek kompaktní či složený z větších kusů. Pro přípravu takového 

vzorku slouží odvrtávání, odbrušování a mletí. Mletí a homogenizace vzorku s využitím 

různých typů mlýnů je také často nezbytným krokem předcházející lisování tablet pro 

laserovou ablaci s ICP nebo rentgenovou analýzu. 

Využití moderních postupů kryogenního mletí a mikrovlnného rozkladu pro přípravu pevného 

vzorku a jeho následná analýza metodami ICP-OES/MS je náplní této úlohy. Papír potištěný 

modrou barvou z běžné inkoustové tiskárny je vhodným vzorkem, na kterém lze 

demonstrovat kryogenní mletí i mikrovlnný rozklad za účelem stanovení mědi v této barvě. 

Příprava vzorku kryogenním mletím 

Při kryogenním mletí se využívá podchlazení 

vzorku tekutým dusíkem. V mlecí nádobce se 

po dosažení kryogenní teploty provádí 

mechanické mletí, které je zajištěno kmitáním 

kovového tělíska v magnetickém poli. Tímto 

způsobem je možné efektivní rozemletí 

materiálů, za normální teploty měkkých a 

elastických (termoplasty, textilie, rostlinné a 

živočišné tkáně) nebo látky, které se za vyšší 

teploty rozkládají. Kryogenní mletí je vhodné 

hlavně pro látky, které jsou ohebné nebo 

plastické při pokojové teplotě. Extrémně nízká 

teplota při mletí vede ke zkřehnutí materiálu a 

zamezení následného shlukování a scelování 

částic. 

Hlavními výhodami kryogenního mletí jsou 

vyšší výtěžky částic v cílené velikosti a lepší 

distribuce velikosti zrnek.  

   V úloze se bude používat kryogenní mlýn 

SPEX 6775 Freezer/Mill (obr. 1) umožňující 

umístění jedné mlecí nádobky. 

 

Obr. 1 Kryogenní mlýn SPEX 6775 Freezer/Mill 
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Postup: 

1) Příprava vzorku 

Na papír se vytiskne na inkoustové tiskárně modrý čtverec o 

celková ploše 10x10 cm. Tento čtverec se vystřihne a nastříhá na 

malé čtverečky cca 1x1 cm a vloží se do mlecí nádobky (obr. 2) 

spolu s mlecím tělískem (impaktorem). 

Spolu se vzorkem je nutné také připravit blank, což je v tomto 

případě nepotištěný list papíru o stejné ploše. Vzhledem k tomu, 

že mletí jednoho vzorku trvá přibližně 25 minut, je vhodné blank 

připravovat během mletí vzorku. Vzorek i blank musí být před 

vložením do mlýna zvážen, aby mohl být po stanovení proveden 

přepočet na plošný obsah Cu v potisku. 

 

2) Mletí 

Nádobka se vzorkem se umístí do mlýna do otvoru na nádobku. 

Je nutné zkontrolovat množství tekutého dusíku v nádržce 

(hladina dusíku v nádržce musí být cca 2 cm pod horní okraj). 

Následně se mlýn uzavře a zajistí zacvaknutím gumové svorky. 

Na obrazovce se spustí program pro mletí papíru. Parametry pro 

mletí jsou uvedeny v tabulce 1. 

 

3) Vyjmutí vzorku 

Po skončení programu na mletí se kryogenní mlýn otevře a mlecí 

nádobka se vytáhne pomocí magnetické tužky. Pozor, s nádobkou je 

třeba zacházet opatrně, protože její kovové části jsou zmrzlé na 

kryogenní teplotu. Nádobka se umístí do otevíracího zařízení (obr. 

3) a vytáhne se zátka. Obsah nádobky se vysype na filtrační papír a 

umístí do exsikátoru.  

 

4) Mikrovlnný rozklad 

Mikrovlnný rozklad se běžně používá k převedení 

vzorků do roztoku pro stanovení prvků metodami 

ICP-MS, ICP-OES nebo AAS. Výhodou 

mikrovlnného rozkladu je zkrácení doby rozkladu, 

snížení množství kyselin a rizika kontaminace či 

rozklad obtížně rozložitelných vzorků. Mikrovlnný 

rozklad může probíhat v otevřeném (za 

atmosférického tlaku) nebo uzavřeném systému. 

Teploty dosažené u otevřeného systému jsou 

limitovány bodem varu kyseliny, uzavřený systém 

umožňuje dosažení teplot až 250 °C. Pro rozklad 

se používají různé minerální kyseliny (např. HCl, 

HNO3, HF, H2SO4…) a peroxid vodíku. Nádobky 

parametr hodnota 
Předchlazení 15 min 
Doba mletí 1,5 min 
Chlazení 2 min 
Počet cyklů 3 
Četnost úderů (rate) 12 cps 

Tab. 1 Parametry pro mletí 

Obr. 2 Mlecí nádobky, spodní 
uzávěr (vlevo), horní uzávěr 

(vpravo) a  impaktor 

Obr. 3 Zařízení na otvírání 
mlecích nádobek 

Obr. 4 Mikrovlnné zařízení ETHOS ONE 
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na rozklad jsou vyrobeny z inertního materiálu (např. teflon) propustného pro mikrovlnné 

záření. Zahřívání v mikrovlnném poli je silně ovlivněno typem vzorku, a proto je nutné 

sledovat teploty jednotlivých vzorků. Rozklad bude probíhat v mikrovlnném rozkladném 

zařízení ETHOS ONE (Millestone) (obr. 4). 

 

Zásady práce s mikrovlnným rozkladným zařízením 

 Nádobky na rozklad musí byt čisté a suché, proto se s nádobkami pracuje 

v rukavicích. 

 Jednotlivé nádobky a jejich uzávěry jsou očíslované, je potřeba sady vždy držet 

spolu. 

 Z mikrovlnného zařízení vede vývod do digestoře, která musí být během rozkladu 

spuštěna. 

 Nádobka číslo 1, referenční nádobka s teplotním čidlem, musí být vždy umístěna na 

pozici číslo 1. V této nádobce je měřena teplota pomocí čidla, proto do této nádobky 

vkládáme vzorek, ne blank. 

Reagenty 

6 ml HNO3 (65%), 2 ml H2O2 (30%) 

Program 

Krok Čas Energie T1  
1 00:15:00  200 náběh 
2 
3 

00:15:00 
00:10:00 

 200 
- 

rozklad 
chlazení 

 

Tab. 2 Parametry pro teplotní program mikrovlnného rozkladu 

 

Postup: 

5) Příprava vzorku 

Asi 0,1 g vzorku se naváží na skleněnou 

lodičku, ta se vloží do rozkladné nádobky 

(obr. 5) a vzorek se z ní spláchne kyselinou. 

Stejným způsobem se naváží a převede 

blank do další nádobky. Obě nádobky se 

vzorky se uzavřou do ochranného krytu a 

následně se poskládá celý segment (obr. 6.). 

Pomocí momentového klíče se utáhne tlakový 

závit, dokud nedocvakne. Takto připravené 

segmenty se mohou rovnoměrně umístit do 

mikrovlnného zařízení. Je nutné vkládat 

alespoň tři nádobky, proto se do třetí nádobky přidá stejné množství chemikálií jako do 

nádobek s blankem a vzorkem. Všechny tři segmenty se následně rovnoměrně rozmístí do 

mikrovlnného zařízení. 

Obr. 6 Kompletní segment pro rozklad 
jednoho vzorku 

Obr. 5 Nádobka 
na mikrovlnný 
rozklad 
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Výběrem čísla pozice na dotykové 

obrazovce ovládání pozice vzorků 

(obr. 7) se disk na umísťování 

segmentů otočí danou pozicí dopředu. 

Referenční nádobka se umísťuje na 

pozici číslo 1 jako poslední. Po 

umístění všech segmentů kromě 

referenčního se na segmenty položí 

vrchní zajišťovací disk, tak jak je 

uvedeno na obrázku 8. Poté se na 

pozici 1 umístí segment s referenční 

nádobkou, do které se kabelem zapojí 

teplotní čidlo. Poté se umístí horní disk 

tak, aby zapadl na segmenty. 

 

 

 

 

 

 

 

 

 

 

 

6) Nastavení programu pro mikrovlnný rozklad 

Na úvodní obrazovce (obr. 9.) je nutné 

zaškrtnout políčka, která jsou zaškrtnutá 

na obrázku (obr. 9.). Zvláště důležité je 

políčko TWIST, bez tohoto hrozí 

ukroucení kabelu teplotního čidla. 

Správnou rotaci rotoru lze ověřit 

stisknutím ikony ventilátoru (obr. 10). 

 

 

 

 

Obr. 7 Obrazovka rozmístění vzorků 

Obr. 8 Segmenty s horním zajišťovacím diskem 

Výstup pro teplotní čidlo 

Horní zajišťovací disk 

Segment se vzorkem 

Spodní disk s pozicemi 

Obr. 9 Úvodní obrazovka pro nastavení 

Obr. 10 Tlačítko na spuštění 
kontrolního otáčení 
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Teplotní program se nastaví v záložce 

Method. Do tabulky na obrazovce (obr. 

11.) se vyplní parametry pro teplotní 

program mikrovlnného rozkladu podle 

tabulky 2. Krok 1 udává čas postupného 

ohřevu vzorku do dosažení požadované 

teploty a krok 2 čas, po který je vzorek 

udržován na požadované teplotě. 

Teplotní profil programu je znázorněn 

na grafu. Pomocí ikony diskety se 

metoda uloží. Pokud je již metoda pro 

rozklad vytvořena, je možné ji načíst 

pomocí ikony záložky. 

 

Samotný rozklad se spustí tlačítkem 

Start, v záložce Run. Poté je možné 

sledovat teplotní průběh, jakož i zbývající 

čas rozkladu na obrazovce (obr. 12). Při 

80 °C se dveře zařízení samy zamknou a 

není možné je otevřít. Po uplynutí doby 

rozkladu je nutné počkat, až se vzorky 

ochladí na teplotu kolem 50 °C.  Poté 

je lze vyjmout a nádobky otevřít pomocí 

momentového klíče. Následně se vzorky i 

blank kvantitativně převedou do 

odměrných baněk o objemu 25 ml. 

 

 

 

Optická emisní spektrometrie indukčně vázaného plazmatu  (ICP-OES) 
Metoda ICP-OES (inductively coupled plasma optical emission spectrometry) je založena na 

detekci záření emitovaného excitovanými atomy a ionty. Vzorek je do ICP spektrometru 

vnášen pomocí zmlžovače ve formě vlhkého aerosolu. V indukčně vázaném plazmatu 

dochází k vysušení a odpaření aerosolu. Odpařený aerosol je poté atomizován a vzniklé 

volné atomy jsou pak excitovány a ionizovány. Při deexcitaci atomů a iontů je emitováno 

záření, které nese analytickou informaci a je měřeno detektorem. Atomy nebo ionty poskytují 

emisní čárová spektra, která poskytují kvalitativní informace (vlnová délka) a kvantitativní 

informace (intenzita čáry). 

 

Atomizační a excitační zdroj 

 

Jako atomizační a excitační zdroj se v ICP-OES využívá výboj v prostředí proudu argonu, 

indukčně vázané plazma. Plazma je definováno jako „kvazineutrální plyn nabitých a 

neutrálních částic vykazující kolektivní chování“. Jedná se tedy o částečně ionizovaný plyn 

obsahující ionty, elektrony a neutrální částice v základním i excitovaném stavu a navenek se 

Obr. 11 Obrazovka pro nastavení programu 

Obr. 12  Obrazovka pro sledování průběhu rozkladu 



8 
 

jeví jako elektricky neutrální. Díky přítomnosti nabitých částic reaguje plazma na elektrická a 

magnetická pole, a tak jimi může být ovlivňováno.  

V praxi se pro plazma upřednostňují 

vzácné plyny, které mají vysokou 

ionizační energii, jednoduchá spektra a 

netvoří stabilní sloučeniny. Vysoká 

ionizační energie umožňuje účinnou 

ionizaci většiny prvků. Pro ICP 

spektrometrii se využívá argonového 

plazmatu, které je schopno ionizovat 

všechny prvky s výjimkou He, Ne a F. 

V ICP dosahuje koncentrace elektronů 

hodnot 1020-1021 m-3, z čehož vyplývá, 

že stupeň ionizace je přibližně 0,1 %. 

Důsledkem vysoké koncentrace 

elektronů je významná intenzita pozadí, 

která je způsobena zářivou rekombinací 

argonu. Maximální intenzita tohoto 

spojitého záření je při 450 nm, čímž je vysvětleno modrofialové zbarvení argonového 

plazmatu. 

 

Optika spektrálních přístrojů 

 

Při deexcitaci částic v plazmatu je emitováno elektromagnetické záření, které se skládá 

z analyticky využitelného záření atomů a iontů pocházejících ze vzorku a záření 

nedisociovaných molekul (OH, CO, N2…), které společně se spojitým zářením plazmatu 

nenese analytickou informaci a vytváří tak rušivé pozadíPro analytické účely je nutné rozdělit 

toto polychromatické záření na jednotlivé složky (emisní čáry), které jsou charakteristické pro 

dané prvky. K tomu slouží tzv. disperzní prvky, mezi které řadíme hranoly, mřížky, filtry... , 

které jsou jednou z nejdůležitějších součástí ICP optického spektrometru, protože jejich 

kvalita ovlivňuje rozlišovací schopnost. Jako disperzní prvky se používají u ICP optických 

spektrometrů výhradně mřížky na odraz, protože hranoly a filtry nedosahují dostačující 

rozlišovací schopnosti. Podle typu zvolené mřížky jsou ICP-OES spektrometry děleny na 3 

základní typy spektrometrů: 

 spektrometr s rovinnou mřížkou konstrukce Czerny-Turner 
 spektrometr s konkávní mřížkou konstrukce Paschen-Runge 
 spektrometr s mřížkou typu Echelle a děličem spektrálních řádů 

 
 
 
 
 
 
 
 
 
 
 

Obr. 13 Indukčně vázané plazma 
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Stanovení Cu na potištěném papíru 

bude probíhat na ICP spektrometru  

iCAP 6500 Duo (Thermo Scientific). 

Tento spektrometr je vybaven 

monochromátorem typu Echelle 

s mřížkou 52,9 vrypů na milimetr. 

Systém umožňuje simultánní měření 

spektra v rozmezí cca 166 – 847 nm. 

 

 

 
Postup: 

7) Příprava vzorků a kalibračních roztoků 

Kalibrační roztoky o koncentraci Cu2+ 1 mg/l, 0,5 mg/l, 0,1 mg/l a 0 mg/l se připraví do 

odměrných baněk 50 ml ze zásobního kalibračního roztoku Astasol (cCu = 1 g/l). Do 

kalibračních roztoků se přidá ideálně stejné množství kyseliny, jaké zbude v roztoku vzorku 

po rozkladu. To ovšem neznáme a nebudeme jej v této úloze zjišťovat. Proto přidáme do 

každého roztoku standardu zhruba polovinu množství, které se přidalo ke vzorku před 

rozkladem. Samotné vzorky již není třeba nijak upravovat.  

8) Nastavení metody 

Spektrometr se ovládá pomocí programu iTEVA (obr. 15). Na spodní liště se vybere ikona 

zámku, pod kterou jsou zobrazené „Interlocks“, které uvádí aktuální stav spektrometru 

(komunikaci s PC, odtah, …) včetně aktuální teploty detektoru (obr. 16). Pokud nesvítí žádný 

Interlock červeně a teplota detektoru je -45°C, pak lze iniciovat plazma. 

 

Obr. 14 ICP Spektrometr ICAP 6000 series 

Obr. 15 Úvodní obrazovka programu iTEVA Obr. 16 Instrument status 
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Obr. 20 Záložky pro nastavení metody 

 

Ikonou plazmové hlavice se otevře okno 

s tabulkou „Plasma status“ (obr. 17), 

kde se vybere ikona Plasma On. Na 

úvodní obrazovce programu iTEVA se 

na levé straně vybere záložka Analyst. 

Nová metoda se vytvoří následně: 

  Method => New 

 

 

 

 

  

 

 

 

 

 

 

 

 

Otevře se okno s periodickou tabulkou (obr. 18) kde se po vybrání měřeného prvku – 

Cu, označí čáry mědi, které se budou měřit (obr. 19). Čáry jsou seřazeny podle 

intenzity, avšak je nutné kontrolovat interference (pravá část). 

 

 

 

 

 

 

 

 

 

Obr. 17 Plasma status 

Obr. 18 Periodická tabulka pro výběr měřených prvků 
Obr. 19 Označení měřených čar mědi 
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Na liště záložek pro nastavení 

metody (obr. 20) se vybere 

možnost Analysis Preferences 

(obr. 21) a zvolí se axiální 

pozorování, které se využívá pro 

stanovení nízkých obsahů prvků u 

vzorků s jednodušší matricí. Záření 

se snímá čelně z osy výboje. 

Radiální pozorování, které se též 

velmi často využívá, znamená, že 

záření je snímáno z boku 

plazmatu.  

 

 

 

Dále se přejde na Source Settings  

(obr. 22), kde se nastaví 

následující parametry: 

 

 

 

 

 

 

Tab. 3 Parametry měření 

 

V okně Standards (obr. 23) se 

nastaví koncentrace pro jednotlivé 

měřené standardy. V případě více 

standardů lze další přidávat 

pomocí ikony Add. Následně se 

metoda uloží a vybere se záložka 

Analyst. 

 

 

 

9) Kalibrace a analýza 

 

Obr. 24 Horní lišta s ikonami 

Parametr Hodnota 
Flush pump rate 75 rpm 
Analysis pump rate 25 rpm 
Pump stabilisation time 5 s 
Nebuliser gas flow 0,65 L/min 
  

Obr. 21  Analysis preferences 

Obr. 22 Source settings 

Obr. 23 Nastavení standardů 
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Obr. 26 Ikona Publisher 

Výběrem ikony měření kalibračních roztoků 

(fialová kádinka (obr. 24)) na horní liště se 

otevře okno Calibration (obr. 25). Hadička pro 

přívod vzorku do zmlžovače se ponoří do 

baňky s kalibračním blankem a spustí se 

pomocí tlačítka Run. Obdobně se postupuje i s 

kalibračním standardem. Po proměření všech 

kalibračních standardů se kalibrace dokončí 

tlačítkem Done. Analýza samotného vzorku se 

spustí ikonou se zelenou kádinkou (obr. 24). 

Před koncem měření většího počtu vzorků je 

vhodné změřit některý z kalibračních bodů jako 

neznámý roztok pro zjištění udržení stability. 

 

 

10) Export dat 

 

 

 

 

 

 

 

 

 

 

 

Naměřená data lze exportovat do souboru přes ikonu  Publisher (obr. 26), přímo pod ikonou 

Analyst.   

New report => Sample report => OK 

Otevře se okno Sample query (obr. 27), kde se nastaví datum měření, popř. se vybere 

metoda. Ze seznamu analyzovaných vzorků se vyberou ty, ke kterým se mají exportovat 

data. Označíme vzorek a potvrdíme stisknutím OK. 

Soubor dat se exportuje následně:  Export => Excel => Save 

 

 

 

Obr. 25 Měření kalibračních roztoků 

Obr. 27 Výběr vzorků pro vypsání zprávy 
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Vyhodnoceni výsledků: 

Získaná hodnota obsahu mědi se přepočítá na obsah mědi [µg] na původní plochu 

potištěného papíru (100 cm2) a následně se hodnota přepočítá na plošný obsah [µg.cm-2] 

(podle návodu k ICP MS). 

Přesnost výsledků je ovlivněna vznikem náhodných chyb, které se vyskytují při každém 

měření. Rozdělení náhodných chyb je možné vyjádřit graficky Gaussovou křivkou. Jako 

odhad parametrů se používá aritmetický průměr a směrodatná odchylka. Avšak při malém 

počtu stanovení n, kdy n < 10, se směrodatná odchylka odhaduje z rozpětí R. 

𝑠𝑅 =  𝑘𝑛 ∙ 𝑅 

Kde kn je Dean-Dixonův koeficient (k3 = 0,5908). 

Interval spolehlivosti 

Při měření neznámého vzorku neznáme skutečnou hodnotu, a proto se vymezuje oblast, kde 

se s určitou pravděpodobností tato hodnota nachází. Tato oblast se nazývá interval 

spolehlivosti a charakterizuje spolehlivost výsledků. Pro malé soubory byl Dean-Dixonem 

navržen způsob, který využívá Lordovo rozdělení. 

𝐿1,2 =  �̅�  ±  𝐾𝛼  ∙ 𝑅 

kde Kα je kritická hodnota Lordova rozdělení pro zvolenou hladinu významnosti α. 

(pro α = 0,05 a 3 opakování měření K3 = 1,304) 

Tento postup nezahrnuje chyby přípravy kalibračních roztoků a měření kalibrační závislosti, 

vychází pouze z opakovaného měření intenzity dané čáry u vzorku. Obvykle se však 

výsledek prezentuje tímto zjednodušeným způsobem bez větší újmy na spolehlivosti analýzy 

ICP. 

Limit detekce a limit kvantifikace 

Limity detekce a kvantifikace se počítají ze směrodatné odchylky �̅�𝐵 (také vypočítaná 

z deseti opakovaných měření blanku) a ze směrnice kalibrační křivky S získané regresi 

z nízkých koncentrací. Následně se hodnota limitu detekce vztáhne na plochu (stejnou jako u 

ICP-MS, aby bylo možné hodnoty porovnat).  

LoD = 
3�̅�𝐵

𝑆
 

Testování shodnosti výsledků 

Pro porovnání výsledků získaných různými metodami se testuje shodnost. Testování 

shodnosti výsledků pro stejný počet paralelních stanovení v obou testovaných souborech 

(nA = nB = n) se nejčastěji provádí podle zjednodušeného Studentova t-testu. Pro malé 

soubory se používá Lordův test, který nevyžaduje žádné předpoklady o rozptylech. 

𝑢 =  
|�̅�𝐴 − �̅�𝐵|

𝑅𝐴 + 𝑅𝐵
 

Je-li u větší než kritická hodnota Lordova testu na zvolené hladině významnosti α, potom je 

rozdíl aritmetických průměrů statisticky významný a výsledky získané různými metodami 

nelze považovat za shodné.  (pro α = 0,05 uα = 0,636) 
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Zdroje: 
 

www.spexsampleprep.com/6775FreezerMill 

ETHOS ONE Operator manual MA133 

SK-10 and SK-12 Segmented Rotors & operator manual MA127 

Holá M., Vaculovič T., 7. kurz ICP spektrometrie, 2013, JMMSS 
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Analytické metody založené na laserové ablaci 

LA-ICP-MS 
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Mapování distribuce Cu v modrém tisku metodou LA-ICP-MS 
 
V nedávné době zaznamenala v analytické chemii laserová ablace velký rozvoj. Metoda 
laserové ablace s indukčně vázaným plazmatem a hmotnostní spektrometrií (LA-ICP-MS) je 
používána pro povrchovou analýzu pevných látek v oblasti geologie, archeologie, biologie 
apod. V posledních letech zájem o studium distribuce zejména stopových prvků roste. 

 
Princip  
Ablační systém je připojen k citlivému ICP-MS spektrometru. Zaostřený laserový paprsek 
interaguje s povrchem vzorku a ablatovaný a částečně ionizovaný materiál je následně 
nosným plynem (He) transportován ve formě suchého aerosolu do ICP, kde je atomizován, 
ionizován a excitován. Ionty pak vstupují do hmotnostního spektrometru, v němž jsou od 
sebe odděleny dle jejich poměru hmotnosti a náboje (m/z) a detekovány detekčním 
systémem hmotnostního spektrometru. 

 
Laserová ablace  
Při interakci laseru s povrchem vzorku dochází k několika dějům. Materiál vzorku je prudce 
zahřát a to i do určité hloubky pod povrch vzorku. Prudký nárůst tlaku uvnitř vzorku vyvolá 
explozi a tříštění povrchové vrstvy (obr. 1) a odpařený a atomizovaný materiál spolu s 
ionizovaným okolním plynem dále absorbuje záření laseru. Vytváří se tzv. laserem 
indukované plazma, v němž jsou atomy i ionty vzorku excitovány. Jedním z hlavních 
parametrů pro tvorbu velikosti částic jsou vlnové délky laserů. Velikost částic je variabilní a 
pohybuje se v rozmezí od jednotek nm až po tzv. aglomeráty o velikosti i 2 μm, které pak ale 
mohou vést ke změnám v intenzitě signálu.  

 
 
 
Indukčně vázané plazma  
Vzorek v plynné formě z laserové ablace je 

pomocí nosného plynu veden do plasmové 

hlavice, kde se nachází ve 

vysokofrekvenčním elektromagnetickém poli 

argonové plazma. Jeho teplota se pohybuje v 

rozsahu mezi 6 000 až 10 000 K v závislosti 

na oblasti plazmatu. Zde dochází k ionizaci 

nejčastěji do prvního stupně. 

 

 
 

Obr. 1 interakce laseru s povrchem vzorku (http://blogs.maryville.edu/aas/files/2013/06/ablation_diagram.jpg) 

 
 
Hmotnostní spektrometr  
Ionty z iontového zdroje (ICP) jsou transportovány přes rozhraní (interface) do hmotnostního 
spektrometru. Rozhraní je tvořeno dvěma kónusy (sampler a skimmer) a dochází zde k 
efektivnímu oddělení toku argonu od středního toku atomů a iontů. Velikost průměrů kónusů 
je přibližně 1 mm a prostor mezi jednotlivými kónusy se nazývá „předvakuum“ s tlakem 
okolo 500 Pa. Část plazmového paprsku tedy vstupuje otvorem přes skimmer do 
hmotnostního analyzátoru. Ještě před tím jsou ale systémem iontové optiky odděleny 
nepotřebné atomy od iontů. V analyzátoru jsou ionty separovány dle zvoleného poměru m/z 
(kvadrupólový analyzátor). Pro potlačení interferencí je zde také umístěna kolizně-reakční 
cela. Následně ionty dopadají na detektor, ten převede proud iontů na signál, který je 
vyhodnocen PC.  
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d) 

Obr. 2: Schéma uspořádání laserové ablace s indukčně vázaným plazmatem a hmotnostní spektrometrií (LA-ICP-

MS). (D. Günther, B. Hattendorf, TrAC (2005), 24(3), 255-265). 

 

  

 

 

Zapnutí přístroje:  

Pod dohledem vyučujícího otočte ventilem (k sobě) pro spuštění argonu (tvorba plazmatu) a 

helia (nosný plyn pro LA) (obr. 3a), dále zapněte chlazení (obr. 3b), otevřete ventil u tlakové 

lahve s heliem (do kolizní cely pro potlačení interferencí, obr. 3c), zapněte laser (otočením 

klíčku a tlačítkem zezadu laseru, obr. 3d,e), zapněte počítač. 

 

 

 

 

 

 

 

Na ploše otevřete ikonu Configuration, kde v části Type zvolíte Laser Ablation. Dále otevřete 

v PC programy ICP-MS-Top a New Wave Research - Laser Ablation System, a následně v 

ovládání průtokoměru (pozor, musí být zapojen v zásuvce) zvolte file → open → vyberte 

číslo sériové číslo průtokoměru → OK. Ve full scale se objeví průtok 2,00 l/min. 

 

a) c) e) b) d) 

Obr. 3: Zapnutí jednotlivých částí přístroje LA-ICP-MS, a) argon, helium, b) chlazení, c) helium do kolizní cely, d) a 
e) zapnutí laseru. 
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Obr. 4: Ablační komora. Obr. 5: Držák se vzorkem. 

 

Postup:  

1. Příprava vzorku 

Pomocí nůžek vystřihneme 

natisknutý vzorek (tak, aby plocha 

papíru byla 10 x 10 mm) a s využitím 

oboustranné lepicí pásky připevníme 

na podložní sklíčko a následně na 

držák, který poté vložíme do ablační 

komory.  

 

2. Nastavení LA-ICP-MS pro měření 

a) Promývání ablační komory  

Aby v ablační komoře nebyl přítomný vzduch, je třeba ji 

propláchnout He. V programu New Wave Research - Laser 

Ablation System přepneme z módu bypass na (vlevo 

nahoře) Purge (obr. 5) a následně zvýšíme průtok He na 50 

% (1,00 l/min). Takto ablační komoru promýváme přibližně 1 

min a těsně před tím, než se ablační komora dostane do 

online modu, snížíme průtok He na 1 %.   

    

         

b) Start ICP   

V programu ICP-MS-Top klikneme na ikonu vlevo nahoře 

→ plazma (obr. 7a)→ on. Po zapálení plazmatu (obr. 6) je 

třeba počkat 45 min, než je možné měřit. Během této doby je 

vhodné nastavit metodu. 

 

c) Nastavení podmínek analýzy 

Ve složce data a methods si vytvoříme vlastní složku s datem analýzy. Dále je nutné 

nastavit podmínky měření v programu ICP-MS-Top: 

 Zvolíme v horní liště Methods (obr. 7a) → Edit entire methods → Zvolíme Method 

information a Aquisition → ok → do prázdného pole stručně popíšeme analýzu (např. 

zobrazení mědi v tiskařské barvě) → Time Resolved Analysis → ok → periodic table (obr. 

7b) zde vybereme 63Cu (obr, 7c)→ integrační čas (obr. 7d)  63Cu  zvolíme 0,1 s → následně 

v Real Time Plot (obr. 7e) zvolíme extrakt → Time window → 500 s (délka zobrazení okna) 

→ OK → Aquisition (obr. 7f) → 2000 s (přibližná délka analýzy) → OK. 

Nyní vybereme (v horní liště) DataAnalysis (obr. 7g) → Main panel → spustí se program 

Online ICP-MS Data Analysis.  

 

 

 

 

Obr. 6: Plazma 

Obr. 5: Přepnutí módů. 
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b) 
a) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICP-MS Data Analysis  

Zde zvolíme ikonu se značkou plus (obr. 8a, zde se budou ukládat výsledky) → data → 

vyberete název Vaší složky →  create (obr. 8b). Nyní je potřeba načíst prvky, které 

budou měřeny → DA Method (obr. 8c) → edit → Analys. Mode → zvolíme Timechard  → 

zvolíme ikonu zelená šipka (obr. 8e) → 3. Ikona zprava (Load List) → methods → název 

Vaší složky → zobrazí se prvky → Return to Batch-at-a-Grance → yes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

V programu New Wave Research - Laser Ablation System (obr. 9) → frekventce (a) 

10 Hz → velikost laserového paprsku (b) 65 µm → fluence (c) 8 J/cm2 (zavřeme 

záklopku (d) následně spustíme laser (e) a přidáváme energii % (f) dokud nedosáhneme 

požadované hodnoty fluence) → Tools (g) → nastavíme linii → vzorek doostříme (h). 

e) 

f) 

c) 

g) 

d) 

g) 

Obr. 7: Nastavení podmínek v programu ICP-MS-Top 

a) c) 

d) 

e) 

Obr. 8: Nastavení podmínek v programu ICP-MS Data Analysis. 
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d) e) c) 
a) b) f) 

g) 

h) 

Obr. 9: Nastavení parametrů v programu New Wave Research - Laser Ablation System. 

 

 

 

 

 

 

 

 

 

Nyní vytvoříme linii dlouhou tak, aby zasahovala od začátku po konec vzorku. V nabídce 

Properties…(obr. 10a) nastavíme parametry analýz – Scan Speed 70 µm/s, Output dle 

energie laseru, Rep Rate 10 Hz a Spot Size 100 µm (obr. 11a, 11b, 11c 11d). V případě, že 

bude nutné změnit délku linie, zvolíme Edit Endpoints…(obr. 10b).  

 

 

 

 

 

 

 

       

 

 

Dle velikosti vzorku a posunu mezi jednotlivými liniemi vypočítáme počet linií 

potřebných na ablaci (obr. 12), následně pak pomocí Duplicate Scans… (obr. 10c) 

nastavíme potřebný počet linií (obr. 13a) a posunutí (obr. 13b). 

 

 

 

 

  

 

 

 

 

Obr. 10: Parametry analýzy a) Properties  

b) Edit Endpoints 

Obr. 11: Nastavení parametrů linie a) Scan Speed b) 

Output c) Rep Rate d) Spot Size 

 

A 
6 cm 

6
 c

m
 

0,150 cm 

Obr. 12: Způsob ablace písmena 

a

b

a) 

b) 

a) 

d) 
c) b) 

c) 

Obr. 13: Duplikace linií. 

b) 

a) 



21 
 

a) 
b) 

c) 

a) 

 

  

Nyní v programu ICP-MS-Top 

spustíme měření → Method → Run 

→ nastavte, kde se budou výsledky 

ukládat (obr. 14 a) → OK → 

pojmenujeme měření (pouze 7 

písmen) → Run Method → následně 

v programu New Wave Research - 

Laser Ablation Systém zahájíme 

ablaci → Run Experiment→ Enable 

Laser During Scans (Obr. 15a) → 

Laser Warmup Time (Obr. 15b) → 

5s → Run (Obr. 15c). 

 

 

Nyní můžeme v programu ICP-MS-Top pozorovat měřený signál (obr. 16). 

 

 

Obr. 15: Spuštění ablace Obr. 14: Spuštění měření v programu 

ICP-MS-Top 

Obr. 16: Graf měřených intenzit mědi v závislosti na čase. 

a) 
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Obr. 17: Tvorba csv souboru z naměřených dat. 

Obr. 18: Naměřená data ve formátu csv. 

Měření ukončíme kliknutím na Stop Run (obr. 16 a). 

V programu ICP-MS Data Analysis importujeme výsledky → File (obr. 17 a) → Import 

Samples → vyberete Vaši složku → ok. Pro získání csv souboru dat klikneme do spodní 

části s grafem pravým tlačítkem myši → Table Chart (obr. 17 b) → csv Data. Nyní se nám 

vytvoří po pár minutách soubor s naměřenými daty (obr. 18). 

 

 

 

 

 

 

 

 

 

a) 

 

b) 
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a) 

b) 

c) 

Obr. 20: Volba synchronizačního prvku v programu Laser Ablation Tool. 

 

Vypnutí přístroje:   

V programu ICP-MS-Top klikneme na ikonu vlevo nahoře (obr. 7a) → plazma → off, dále 

zavřeme všechny programy, vypneme počítač, chlazení, plyny, laser. 

 

Vyhodnocení naměřených dat: 

Pro zpracování naměřených dat nám poslouží program Laser Ablation Tool. Nejprve 

načteme naše data (obr. 19a a následně 19b) → Load Data from Select File (obr. 19c) → 

Next (obr.19d). 

 

 

Nyní vybereme synchronizační prvek (měříme pouze jeden prvek, synchronizačním prvkem 

tedy bude Cu, obr. 20a). Dále nastavíme hranici pozadí (obr. 20b) a zvolíme Next (obr. 20c). 

 

 

 

 

 

 

 

 

 

 

Obr. 18: Naměřená data. 

a) 

b) 
c) 

d) 

Obr. 19: Načtení naměřených dat v programu Laser Ablation Tool. 
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V dalším okně je třeba určit hranice mezi jednotlivými liniemi. Modrá čára (obr. 21a) určuje 

konec linie (tuto hodnotu vepíšeme do pole time of first falling edge, obr 21b). Červená čára 

určuje začátek linie (odečteme tuto hodnotu (obr. 21c) od hodnoty konce linie a zapíšeme do 

pole period of signal (obr 21b)). Nyní do pole rising a falling edge minimal step (obr. 21d) 

zapíšeme takovou hodnotu, aby se jednotlivé linie po kliknutí na Recount (obr. 21e) zbarvily 

do šeda (typicky hodnotu 0,3) a klikneme na políčko Next (obr. 21f). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dále zapíšeme rychlost posunu vzorku (obr. 22a) a vzdálenost mezi jednotlivými liniemi (obr. 

22b) a klikneme na políčko Finish (obr. 22c). 

 

 

 

 

 

 

 

 

 

Obr. 21: Určení intervalů synchronizačních časů. 

a) c) 

b) 
d) e) 

f) 

Obr. 21: Výběr intervalů synchronizačního času. 

 

Obr. 22: Nastavení parametrů laseru. 

a) 
b) 

c) 
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a) 

b) 

Obr. 24: Tvorba mapy. 

b) 
c) 

d) 

a) 

e) 

 

Pro uložení zpracovaných dat klikneme na ikonu XLS (obr. 23a), soubor pojmenujeme a 

uložíme (obr. 23b). 

 

Nyní vytvoříme v programu excel barevnou mapu. Soubor uložený z programu Laser 

Ablation Tool otevřeme. Matici dat označíme (obr. 24a) → vložení (obr. 24b) → grafy (obr. 

24c) → šablony (obr.24d) → vybereme vhodnou šablonu (obr. 24e) → ok. 

 

Obr. 23: Uložení zpracovaných dat. 
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a) 

b) 
c) 

d) 

e) 

Takto vytvořený graf přesuneme do nového listu (obr. 25) → klikneme pravým tlačítkem myši 

→ přesunout graf → nový list → pojmenujeme např. Cu graf. 

 

 

 

 

 

 

 

 

 

 

 

Nyní je třeba upravit škálu zobrazení → klikneme pravým tlačítkem myši na okraj grafu (obr.  

 

26a) → zvolíme formát osy → možnosti osy (obr. 26b)→ minimum 0 (obr. 26c) → maximum 

(přibližná maximální hodnota intenzity Cu – obr. 26d) → hlavní jednotka (o jeden řád nižší, 

než maximální hodnota – obr. 26e). 

 

 

Obr. 25: Přesun grafu do nového listu. 

Obr. 26: Zvolení vhodných parametrů osy grafu. 
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Z takto vytvořeného grafu vystřihneme obrázek → výstřižky → nový → označíme plochu 

obrázku → uložit. Obrázek otevřeme v programu XnView a upravíme poměry stran (zjistíme 

v excelovském souboru) → obrázek → rozměry → zapíšeme hodnoty (obr. 27a) → obrázek 

také přetočíme o 180 º (obr. 27b) → a uložíme. 

 

 

 

 

 

 

 

 

 

 

 

 

 

K obrázku přiložíme škálu → obrázek → panorama → přidat (obr. 28a) → vybereme náš 

obrázek s upravenými poměry stran → přidat (obr. 28b) → dále vybereme již předem 

vytvořenou škálu → přidat → ok (obr. 28c) → vytvořit (obr. 28d). 

 

a) 

b) 

Obr. 27: Úprava rozměrů stran. 

Obr. 28: Vytvoření panoramatického obrázku. 

b) 

c) 

a) 

d) 
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Nakonec vložíme popisky (jednotky, hodnoty intenzit atd.) → obrázek → přidat text → 

napíšeme text (obr. 29) → ok → myší text umístíme do obrázku → obrázek uložíme. 

 

 

Vyhodnocení výsledků: 

Pro srovnání obou laserových technik (LIBS a LA-ICP-MS) jsou důležité 3 parametry - limit 

detekce, relativní rozšíření vytištěné linie a doba analýzy. Jelikož doba analýzy je přibližně 

stejná, porovnejte následující dva parametry a zhodnoťte, která z metod má lepší citlivost 

(dle LOD) a laterární rozlišení (dle ΔWrel). 

 

 Výpočet limitu detekce (LOD): 

𝐿𝑂𝐷 =
3 ∙ 𝑆𝐷 ∙  𝑚𝐶𝑢

𝐼𝐶𝑢
 

 

Kde: 

SD směrodatná odchylka pozadí (bráno z min. 10 hodnot pozadí – intenzita mědi ve 

chvíli, kdy nedochází k ablaci). 

ICu průměrná intenzita Cu alespoň z 5 hodnot  na modrém potisku (viz. obr. 30) 

mCu hmotnost mědi na ploše kráteru o průměru 100 µm [fg] 

 

Obr. 29: Vytvoření panoramatického obrázku. 
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Obr. 31: Stanovení zdánlivé šířky. 

a 

b 

c d Δl 

 

Pro výpočet hmotnosti mědi vztaženou na plochu kráteru budeme postupovat 

následovně: 

Z roztokové analýzy známe stanovený obsah Cu (mcelk) v celé ploše (Scelk) natisknutého 

papíru, kterou si vztáhneme na plochu kráteru vypočítanou z průměru laserového paprsku  

100 µm (plocha kráteru je ve skutečnosti větší, než plocha laserového paprsku Sp, ale pro 

první přiblížení budeme předpokládat, že se tyto hodnoty rovnají). 

 

𝑆𝑝 =  𝜋𝑟2 = 3,14 ∙ 502 = 7854 𝜇𝑚2
 

𝑚𝐶𝑢 =  
𝑆𝑝 ∙  𝑚𝑐𝑒𝑙𝑘

𝑆𝑐𝑒𝑙𝑘
 

 

 

 

 

 

 

Výsledný limit detekce vztažený na plochu kráteru [fg] pak následně vztáhneme na 

jednotkovou plochu [µm2]. 

 

∆𝑊𝑟𝑒𝑙 =  
∆𝑙− 𝑙𝑟

𝑙𝑟
 ∙ 100Relativní rozšíření vytištěné linie (ΔWrel): 

 

Kde: 

Δl zdánlivá šířka vytištěné linie z obdržené mapy [mm] 

lr reálná šířka linie [mm] – hodnotu zjistíme změřením pod mikroskopem v programu  

New Wave Research - Laser Ablation System). 

 
 

 

 

 

 

 

 

 

 

1
0

0
 m

m
 

100 mm 

Scelk A 
Sp 

Obr. 30: Parametry pro výpočet LOD. 

lr 
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Pro zjištění relativního rozšíření ablatované vytištěné linie - ΔWrel [%] sledujeme signál 
63Cu. Měď je přítomna jen v natištěném písmenu, nikoli v čistém papíře, případně je zde jen 

minimální množství. Z obrázků č. 31 je patrný záznam ablatované linie při dané rychlosti 

posunu vzorku. Zdánlivá šířka je vzdálenost mezi nástupem signálu získaného z LA-ICP-MS 

a koncem jeho poklesu, kdy laserový bod projde přes inkoustové linie. Počáteční a koncové 

body získáme jako průsečíky spojnic c,b, a a,d, v tomto pořadí (obr.č. 31). Linie c a d 

získáme z lineární regrese v oblastech signálu zaznamenaného v prostoru mimo inkoust, 

zatímco linie a a b získáme lineární regresí v oblastech vzestupu a poklesu signálu. Míra 

laterárního rozlišení zobrazování je tedy kvantifikována jako relativní rozšíření (ΔW rel ) 

ablatované tloušťky natisknutého písmena (lr). 

 

Do protokolu uvedeme: 

 

 Obrázek distribuce mědi v písmenu A analyzovaný pomocí LA-ICP-MS a LIBS. 

 Výpočty relativního rozšíření vytištěné a limitů detekce. 

 Na základě těchto parametrů porovnejte tyto dvě metody z hlediska citlivosti a 

laterárního rozlišení (tabulka pro porovnání). 

 Následně dle vypočítaných LOD vztažených na plochu porovnáme metody roztokové 

analýzy (ICP-MS a ICP-OES) a metody zobrazování (LIBS a LA-ICP-MS) – tabulka 

pro porovnání, výsledky převeďte pro porovnání na stejné jednotky. 
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Spektrometrie laserem buzeného plazmatu 

LIBS 
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Mapování distribuce Cu v modrém tisku metodou LIBS 
 

Princip 
Spektroskopie laserem buzeného plazmatu (LIBS = Laser Induced Breakdown 
Spectroscopy) je metoda atomové emisní spektrometrie, která využívá záření 
mikroplazmatu, vznikajícího po interakci fokusovaného laserového svazku se vzorkem.  
 
Laserový pulz dopadající na povrch vzorku způsobí prudké zahřátí materiálu a následnou 
ablaci, při které dochází k uvolnění malého množství materiálu (řádově desítky až stovky ng) 
a ke vzniku mikroplazmatu jehož záření je následně snímáno a spektrometricky 
vyhodnoceno.  Po skončení laserového pulzu dochází k rozpínání mikroplazmatu a emisi 
kontinuálního brzdného záření. Po době řádově několika set nanosekund se začne 
mikroplazma významně ochlazovat, intenzita brzdného záření klesá a ve spektru zůstanou 
již pouze charakteristické emisní čáry iontů nebo atomů. Na základě přiřazení čar 
jednotlivým prvkům je možné stanovit chemické složení vzorku (obr. 1). 
 

 
Obr. 1 Schéma procesů ve spektroskopii laserem buzeného plazmatu [1] 

 

Metoda nevyžaduje prakticky žádnou přípravu vzorku a je možné ji používat na vzduchu při 
atmosférickém tlaku. S výhodou lze používat i dálkové formy, tzv. remote LIBS využívající 
optického vlákna nebo stand-off LIBS s teleskopem. Metoda je mikrodestruktivní, a lze ji tedy 
využít v případech, kdy při použití jiných technik dochází ke znehodnocení vzorků v průběhu 
analýzy. 
Vzhledem k prostorovému rozlišení lze pomocí LIBS také vytvářet hloubkové profily (obr. 2), 
či povrchové mapy (obr. 3) a sledovat tak 2D nebo 3D rozložení prvků. V případě 
hloubkového profilu je laserový pulz vysílán opakovaně do jednoho místa. Pro každý pulz je 
snímáno spektrum a následně je sledována závislost intenzity záření na pořadí pulzu pro 
daný prvek. Hloubkové profilování je vhodné například pro rozlišení jednotlivých vrstev u 
vrstevnatých vzorků. Při povrchovém mapování je provedena analýza v předem určeném 
rastru bodů v ploše, přičemž do každého bodu rastru je vyslán jeden pulz a snímáno 
spektrum. Jednotlivé prvky přítomné na mapovaném povrchu lze odlišit barevně a vytvořit 
tak přehledné mapy jejich rozložení.  
 

  
Obr. 2 Ukázka hloubkového profilu třívrstvého vzorku Obr. 3 Ukázka povrchové mapy 
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Instrumentace 
Modifikovaný ablační systém New Wawe UP-266 MACRO (Obr. 4) je vybaven 
pevnolátkovým Nd:YAG laserem pracujícím na čtvrté harmonické frekvenci (~ 266 nm). 
Vzorek je snímán kamerou a držákem vzorku je možno pomocí softwaru pohybovat v osách 
x a y, což umožňuje skenování povrchu zkoumaného materiálu. Nevyužívá – li se ablační 
cely, probíhá měření vzorků na vzduchu pod atmosférickým tlakem. Emise mikroplazmatu je 
pomocí optického vlákna snímána a přenášena do monochromátoru typu Czerny-Turner 
(Jobin Yvon, TRIAX 320, Francie) a detekována pomocí detektoru s intenzifikovanou CCD 
(iCCD) kamerou (PI-MAX 3, Princeton Instruments, USA). Signál je následně vyhodnocen 
jako závislost intenzity záření na vlnové délce a lze jej dále zpracovávat pomocí dalšího 
software.  
 

 
Obr. 4 New Wawe UP-266 MACRO 

 

Zapnutí přístroje: 
 
1) Otočte klíčkem power supply laserového systému UP-266 MACRO 
2) Zapněte laser UP-266 MACRO spínačem 0/I na zadní straně laseru  
3) Zapněte počítač Dell (černý) 
4) Spusťte program MEO laser 

 

 

  
 

 

 

 

1)                    3)            

2) 
4) 
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5) Zapněte oba delay generátory spínačem POWER do polohy ON 
6) Zapněte generátor a děličku pulzů, obě hodnoty jsou předem nastaveny na 005 (~ 2 Hz) 
7) Zapněte zdroj a řídící jednotku detektoru spínačem 0/I na zadní straně zdroje 
8) Zapněte druhý počítač (šedý HP) 

   
9) Spusťte program Winspec. Zvolte Restore to last setting. 

 

   
 

10) Zapněte ICCD kameru spínačem ON/OFF na zadní straně detektoru 
 

 
  

5) 

6) 

7) 
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Postup analýzy 

1) Příprava vzorku 
Nůžkami vystřihněte natisknutý vzorek. Pomocí oboustranné lepicí pásky upevněte vzorek 
k podkladové destičce, destičku následně vložte na držák. Vzorek srovnejte na střed a 
rovnoběžně podle os v počítačovém programu.  
 

   
 

Rozsviťte světlo nad držákem vzorku v režimu Ring 
 

         
 

 

Zaostřete vzorek pomocí šroubu mikroposuvu.  
 

Ovládání držáku vzorku: 
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2) Nastavení experimentu 
 

Nejdříve si na druhém počítači nastavíme spektrometr a detektor. Charakteristické čáry mědi 
se nacházejí na vlnové délce 324,7 nm a 327,4 nm. V programu Winspec proto nastavte 
vlnovou délku na 327 nm. Zvolte Spectrograph → Move…→ Move to: 327 nm. Předem je již 
nastavena mřížka (grating) č. 2 (2400) a štěrbina (slit) 0,6  
 

 
 

Zvolte modré tlačítko Pulse a nastavte Gate Width na 5 µs a Gate Delay na 0,5 µs. Stiskněte 
Apply. 
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Zvolte Acquisition → Experiment Setup… → záložka Main → nastavte Number of Spectra na 
1800.  
     …→ záložka Data File → nastavte Name: SESKUPIT ve 
složce C:\Program Files\Princeton Instruments\Winspec\Cviceni SESKUPIT 
 

 
 

 
 
Nyní na prvním počítači v programu MEO laser nastavte velikost průměru kráteru na 780 µm. 
Energii laseru nastavte na 80 % 
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V programu MEO laser zvolte File → Open Experiment… → otevřete rastr 30x30 
seskupit.LAE  
 

 
 

 
 
Zvolte Properties a zkontrolujte nastavení parametrů podle tabulky 
 

 
 

 
 
 
 
 
 

Zde nastavená hodnota nemá na frekvenci 

vliv, laser je napojen na děličku pulzů 
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Polohu červeného osového kříže nastavte přibližně podle obrázku. Zvolte Options → Move 
Scans to Crosshairs. Zkontrolujte, že je vzorek přibližně ve středu rastru 
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3) Vlastní měření 
 

V programu Winspec stiskněte zelené tlačítko ACQ (Acquire) 
 

 
 
Rozostřete vzorek pomocí otočného šroubu. 
 

 
 

 

V programu MEO laser zvolte Run Scans → zaškrtněte Manually Control Valves a Enable 
Laser During Scans 
 
!!!PŘED ZAPNUTÍM LASERU SI VŽDY NASAĎTE OCHRANNÉ BRÝLE!!! 
 
Zvolte Run 
 

 
 

Doba měření ~ 25 minut 
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Obr. 5 Rastr použitý pro mapování povrchu – v jedné linii je vždy 30 bodů o průměru cca 100 µm, šipky 
znázorňují směr měření jednotlivých bodů v rastru  
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4) Export dat 
V programu Winspec zvolte záložku Tools → Convert To ASCII 
 

 
 

Zvolte Choose Files → Oblast hledání: C:\Program Files\Princeton 
Instruments\Winspec\Cviceni SESKUPIT → Vyberte a otevřete poslední soubor.  
Zvolte Choose Output Directory → C:\Program Files\Princeton Instruments\Winspec\Cviceni 
SESKUPIT 
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Pro vybrané soubory zvolte Convert To ASCII. Ve složce C:\Program Files\Princeton 
Instruments\Winspec\Cviceni SESKUPIT zkontrolujte vytvoření souboru SESKUPIT.txt 
 

  
 

5) Zpracování dat 
 

Zkopírujte soubor SESKUPIT.txt na plochu. Na ploše otevřete příslušný excelový soubor 
SESKUPIT.xlsx → zvolte list Original data → zvolte záložku Data → v prvním oddíle Načíst 
externí data zvolte Z textu → z plochy importujte soubor SESKUPIT.txt 
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V okně Průvodce importem textu (1/3) a (2/3) neprovádějte žádné změny a zvolte Další → 
v okně Průvodce importem textu (3/3) neprovádějte žádné změny a zvolte Dokončit  → 
v tabulce Importovat data zkontrolujte umístění dat dle obrázku a zvolte OK 
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Přístroj do datového souboru mezi naměřené hodnoty vkládá, vždy jako sudý, řádek bez 
informace, tyto sudé řádky je tedy třeba odstranit. Klikněte na pole A1 v listu Original data a 
zvolte Ctrl+Shift+S. Data z lichých řádků budou překopírována do listu 1. smazání řádků. 
 

            
 
Z datového souboru vykopírujte sloupec s vlnovou délkou 324,7 nm, při které intenzita 
signálů dosahuje maximálních hodnot, do listu 2. rozdělení řádků.  
 
Vzhledem k průběhu měření rastru je potřeba vždy 30 hodnot ze sloupce transponovat do 
řádku přičemž dalších 30 hodnot je nutno transponovat do řádku a zároveň obrátit pořadí 
hodnot (změna směru pohybu v rastru na každém druhém řádku).  
 
Klikněte na pole A3 a zvolte Ctrl+Shift+L pro transponování lichých řádků. Následně 
analogicky zvolte Ctrl+Shift+P pro obrácení a transponování sudých řádků. Výstupní data 
pro tvorbu prvkové mapy se zobrazí na listu Finální tabulka 
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Vyberte všechny hodnoty v tabulce → zvolte kartu Vložení → Grafy → Šablony → vyberte 
šablonu dle obrázku 
 

 
 

Upravte svislou osu prvkové mapy tak, aby maximální hodnota na ose přibližně odpovídala 
maximální hodnotě naměřených intenzit. 
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V programu MWSnap (ikonka fotoaparátu na liště) zvolte Libovolný úhelník a vyberte pečlivě 
oblast mapy → obrázek uložte na Plochu → otevřete v programu XnView 
 

   
 

 
 
V programu XnView zvolte záložku Nástroje → vyberte Panorama… 
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V okně Panoramatický obrázek zvolte Přidat… → v okně Zvolte soubory vyberte vámi 
uloženou mapu a zvolte Přidat, následně vyberte obrázek škála 1 a zvolte Přidat → zvolte 
OK → zpět v okně Panoramatický obrázek se přidají vybrané soubory, poté klikněte na 
Vytvořit… 
 

 
 

 

Zvolte záložku Obrázek → Přidat text → přidejte popisky dle obrázku → výslednou mapu 
zkopírujte do protokolu 
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VYHODNOCENÍ: 
 

Prvkové mapy získané pomocí obou technik (LIBS a LA-ICP-MS) vizuálně porovnejte a 
popište rozdíly.  
 
Pro další srovnání obou technik vypočítejte limit detekce (LOD) a laterální rozlišení (dle 
Δwrel). 
 

Výpočet limitu detekce: 

 
 

𝐿𝑂𝐷 =
3 ∙ 𝑆𝐷 ∙  𝑚𝐶𝑢

𝐼𝐶𝑢
 

 

 

 

Kde: 
SD směrodatná odchylka pozadí (naměřeno na bílém papíře mimo potisk) 
ICu průměrná intenzita Cu alespoň z 5 hodnot na modrém potisku (viz.  LA-ICP-MS) 
mCu hmotnost mědi v fg  na ploše kráteru o průměru 100 µm (roztoková analýza) 
 

 
Pro výpočet hmotnosti mědi vztažené na plochu kráteru budeme postupovat následovně: 
Z roztokové analýzy známe stanovený obsah Cu (mcelk) v celé ploše (Scelk) potištěného 
papíru, kterou si vztáhneme na plochu kráteru vypočítanou z průměru laserového paprsku 
100 µm (plocha kráteru je ve skutečnosti větší, než průměr laserového paprsku Sp, ale pro 
první přiblížení budeme předpokládat, že se tyto hodnoty rovnají). 
 

𝑆𝑝 =  𝜋𝑟2 = 3,14 ∙ 502 = 7854 𝜇𝑚2 

 

 

𝑚𝐶𝑢 =  
𝑆𝑝 ∙  𝑚𝑐𝑒𝑙𝑘

𝑆𝑐𝑒𝑙𝑘
 

 

Výsledný limit detekce vztažený na plochu kráteru [fg] následně vztáhneme na jednotkovou 
plochu [µm2]. 
 

 
Relativní rozšíření vytištěné linie (ΔWrel): 
 

𝛥𝑤𝑟𝑒𝑙 =  
𝛥𝑙 − 𝑙𝑟

𝑙𝑟
 ∙ 100 

 

Kde: 
Δl zdánlivá šířka vytištěné linie z obdržené mapy [mm] 
lr reálná šířka linie (změřte pod mikroskopem v programu MEO laser) 
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Obr. 6 Odvození zdánlivé šířky čáry z grafu 

 

 

Postup pro výpočet relativního rozšíření ablatované wrel čáry viz návod pro „Zobrazování 

pomocí  

LA-ICP-MS“ na základě grafu (obr. 6). 

Do protokolu uvedeme: 
 

 Obrázky distribuce mědi v písmenu A analyzovaný pomocí LA-ICP-MS a LIBS 

 Výpočty relativního rozšíření vytištěné linie a limitů detekce 

 Na základě těchto parametrů porovnejte tyto dvě metody z hlediska citlivosti a 
laterárního rozlišení 

 Následně dle vypočítaných LOD vztažených na plochu porovnejte metody roztokové 
analýzy (ICP-OES a ICP-MS) a zobrazovací metody (LA-ICP-MS a LIBS) 
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